Digital literacy training

ENVS1001 & ENVS6101
Environment and Society: the geography of sustainability

Tutorial to Support Your Essay
2019
Table of Contents

ENVS1001 Essay Assignment ................................................................. 1
Brainstorming, Mind Mapping, and Background Resources ......................... 5
Background material ............................................................................ 6
Subject guides ...................................................................................... 6
Boolean Operators ............................................................................... 7
ANU Library Catalogue ........................................................................ 8
Websites vs Journal Articles .................................................................. 10
Peer Review .......................................................................................... 10
Using Databases to Find Journal Articles .............................................. 11
Useful Databases for Environmental Sciences ........................................ 12
Scopus .................................................................................................. 12
5 Minute exercise: ............................................................................... 15
SuperSearch ......................................................................................... 16
5 Minute exercise: ............................................................................... 16
Google Scholar ..................................................................................... 17
Google Advanced Search ....................................................................... 19
Evaluating Internet Material ................................................................. 20
Referencing ......................................................................................... 20
EndNote for managing citations and research ....................................... 22
Inserting EndNote citations into a document ....................................... 30
ArticleReach ......................................................................................... 32
BONUS+ .............................................................................................. 32
Document Supply Service ..................................................................... 32
Off-campus access ............................................................................... 32
For Further Assistance ......................................................................... 32
Other resources ................................................................................... 33
ENVS1001 Essay Assignment

Learning Objectives for this session

At the end of this session students will be able to:

- Search the Library Catalogue to discover books available in the ANU Library collection
- Understand peer review and why it is important.
- Use databases such as Scopus, SuperSearch and Google Scholar to discover journal articles, and identify other databases to search for your topic.
- Locate the full text of journal articles.
- Evaluate Internet material.
- Become familiar with EndNote for managing your references

ASSIGNMENT    Essay plan

1

Due date: Sunday 31st March by midnight
Weighting: 10%
Length: 1,000 words
Learning outcomes: 2

Essay
Students are required to research and submit an essay of 2,000 words. The word count excludes the reference list, but includes in text referencing. Fenner School policies on late submission, academic honesty and word counts apply. You must use the Harvard referencing style. Your final essay must include a minimum of 8 peer reviewed journal articles (written in English) although you are encouraged to have more. At least 4 of these articles must have been published in the last five years. You can also include less authoritative sources such as websites, media articles, etc where relevant, but this is additional to the peer review journal articles. The tertiary level research skills tutorial early in the course will help you learn how to find the best information, so have your topic / case study ready before then so that you can use the tutorial time to access the articles that you need for your essay. In order to help you produce a high quality essay, you are first required to submit a short essay plan. We will assess this and give you feedback in time to improve your essay before it is submitted.

Essay question
Critically assess the following statement: "Managing the environment sustainably is about social choices as much as science." Assess the statement with respect to a case study of a key place or sustainability issue of interest to you.

Important readings
On the Wattle course page there is important information that you should read, including Fenner School policies on late submission, academic honesty and word counts, a guide to essay writing and feedback on what does and doesn't work in essays.
What is a case study?

Choosing a case study is about choosing a specific resource issue and or place to focus and frame your exploration of the essay question in and around. It sets a boundary or scope to your essay so that you can talk about the broader question in relation to a particular landscape or resource use issue. Scale is an important issue in the course and often the issues discussed during the course happen on a global scale. For a short essay like this it may be difficult or impossible however to effectively explore a global issue in all its complexity and interconnection. Focusing in on a specific landscape and or a specific resource issue will give you a clear focus for doing your research and dealing with an appropriate level of complexity. Focusing the essay to a specific landscape will also allow you to talk about the specific issues and stories of the people there and the interconnections between groups of people with each other, the land, environment, ecology of that place. Picking a case study gives you a real place with particular conditions in which to analyse the quote, by researching the literature relevant to that specific place and resource/environment issue.

Essay plan exercise

You must submit an essay plan of 1,000 words (maximum; not including a Harvard style references). In your essay plan, you focus on finding information relevant to your essay and you start outlining your argument. This exercise requires you to learn to:

1. Select recent and relevant items using research Library catalogues.

2. Access refereed scholarly journal literature using online and electronic index systems (such as Expanded Academic, Sociological Abstracts &/or APAIS),

3. Use and report on refined research techniques that enable you to focus your search and locate scholarly articles of high relevance.

4. Write annotated bibliographies in your own words for a book or a refereed journal article.

5. Explore the kind of information available from the Internet, including from government sights such as the Australian Bureau of Statistics.

6. Use the Harvard system, sometimes called in-text referencing or the author-date system to create a bibliography

Please refer to your course outline pg. 14 for the Essay plan instructions and marking criteria.
ASSIGNMENT Learning portfolio

Due date: Sunday 14th April by midnight
Weighting: 10%
Length: 1,000 words maximum
Learning outcomes: 4

Task description – what is a learning portfolio?
The learning portfolio assignment will require you to reflect on and revise one of the tutorial tickets that you prepare ahead of each tutorial from weeks 2 to 5. After tutorials on April 5th you will be emailed (and it will be advised on Wattle) which one of the four tute tickets that you should reflect on, revise and expand up to 1,000 words.

The learning portfolio task is designed to help you connect your existing knowledge with ideas, concepts, and issues that you are exposed to in the course. The learning portfolio will help you to make sense of the course by drawing upon what you have already learned through life experience, other courses, and in earlier lectures and panels of this course, by providing you with a structured means for recording and connecting your learning. Ultimately keeping a record of your engagement with the course as you move through it will allow you to bring lessons together to build an overall view of the course and its key issues.

Process:
In each of weeks 2-5 you must have undertaken the tutorial reading, written answers for the questions for that week in ~400 words, and hand in a hardcopy of this ticket on arrival at the tutorial. This hard copy will not be assessed for its content. However you cannot participate in the tutorial until you have prepared the ticket, so as to add value to the discussion with other students who have done their homework. If you do not attend the tutorial with a ticket you will lose part of your participation grade.

Content:
We are looking for evidence in your learning portfolio of deep and reflexive learning. Reflection is a way of thinking. It means thinking critically about the ideas presented in course material, weighing up the arguments and reacting to them in logical prose that shows your engagement. Detailed description of concepts, definitions and facts does not constitute adequate engagement with course material: your reflections need to be analytical.

Taking a ‘thematic’ approach is key to constructing excellent analytical reflections. A theme will connect various elements of course content (lectures, tutes, readings etc) with a common idea or thread. Illustrating these connections will be pivotal to communicating your reflections well. For the reflective learning, we want you to describe how your ideas about environment and society have or have not changed as a result of the ideas presented in the course. We want to see how you have understood course concepts and related them to your own experiences of the place/s that you come from, your life and community, and other studies that you are undertaking. Short examples help. For deep learning we are looking for examples of how you have linked different concepts presented in the course and used them to develop new ideas about sustainability with the people and places relevant to you.
You will prepare a number of figures (drawings) in the tutorials. You are welcome to scan or redraft any of these to illustrate points that you make in the text (and of course, figures are not included in the word count). Remember the academic rule that all figures must have captions below them, and for tables a caption above the data. References are not required for this assignment, but if you are talking about a tutorial reading, e.g. Measham & Baker (2005), then you should cite it formally (and the reference list is in addition to the word limit). Lectures should be referenced with the name and date of particular presenters.

**Key concepts:** Different people have different values and perspectives on the environment and society. This makes reaching agreement on how to manage the environment more challenging.

**Please refer to your course outline pg. 16 onwards for the Learning portfolio marking criteria.**

---

**ASSIGNMENT**

**Learning portfolio**

**Due date:** Sunday 2nd June by midnight

**Weighting:** 35% for ENVS1001, 30% for ENVS6101

**Length:** 2,000 words

**Learning outcomes:** 2 & 4

Your essay should be submitted on TurnItIn. See the discussion in the essay plan section in your course outline for relevant rules and policies.
Brainstorming, Mind Mapping, and Background Resources

There are possible approaches to your essay question. You need to choose one of these angles to research. There are a number of ways to do this. Some options are brainstorming, mind mapping, and locating background sources that discuss the topic in some detail.

Example:
What are the issues around food security for island nations?

**Brainstorming**
The idea with brainstorming is that you write down anything that comes into your mind related to the topic. Try not to be critical initially. Remember that this is a starting point and then you can decide which of the ideas that you have come up with in your brainstorming session seem most appealing to research. You might like to brainstorm with a friend or small group to increase the range of ideas initially available. Here’s the start of a brainstorming on the topic above. It can go on and on, so you need to decide when you think you have enough ideas to select from.

**Island nations; Pacific islands; atolls; salinity; agriculture and lack of food; overfishing; international community assistance; cultural impact; arable land; land management; erosion; fresh water supply; overcrowding; climate change; exports/imports.**

**Mind mapping**
Similar to brainstorming, but mind mapping helps you to see how ideas relate to one another. This helps you to see what you know and maybe some areas that you would like to explore further. Here’s a mind map about the factors.

From: [http://sspp.proquest.com/static_content/vol7iss1/communityessay.winowiecki-print.html](http://sspp.proquest.com/static_content/vol7iss1/communityessay.winowiecki-print.html)
Background material

Background material, often called reference works, can help you identify specific angles on your topic that you might wish to explore. Types of background materials include encyclopaedias and textbooks.

Encyclopaedias

Encyclopaedias can be found on the Library catalogue. A topic or keyword search can be done within the resource to find reference material on your topic.

- Encyclopedia of environment and society [electronic resource]
- Encyclopedia of geography [electronic resource]
- Water encyclopedia [electronic resource]

Subject guides

Many online reference works related to Environment and Society are listed in the Environment and Society subject guide under Reference sources with the URL libguides.anu.edu.au/environment_society
**Boolean Operators**

Boolean operators consist of **AND**, **OR** and **NOT**. Many databases automatically add AND between your search terms.

Combining keywords with **AND** narrows the search, by requiring the resources found to match both search terms.

![Boolean Operators Diagram]

The orange area represents the search results.

Note that when typing in multi-word terms, such as “government policy” AND “climate change” you can enter the search putting multi-word phrases in quotes.

Combining keywords with **OR** broadens the search by allowing the records found to match either term.

![Boolean Operators Diagram]

The green area represents the search results.

Searching for “climate change” OR “global warming” finds 386 records in the ANU Library catalogue that contain either keyword phrase.

It is then possible to combine these searches using parentheses:

“government policy” AND (“climate change” OR “global warming”)
ANU Library Catalogue

You can search the ANU Library Catalogue from the ANU Library Homepage, anulib.anu.edu.au

If you want to search by title, author, words, subject, or course go to advanced catalogue search. The default is a keyword search. If you know a title, select title search instead.

To search for books, type words that you wish to search for and click Go.
Remember to be fairly broad with the terms that you use to search for books. Books tend to be more general than journal articles. You may want to use the table of contents or index of a book to locate the specific subject that you need.

For example, books that are on climate change and government policy are likely to contain information on the policies of governments regarding sea level rise resulting from climate change.

However, typing in government policy and sea level rise in the Library Catalogue only retrieves 5 items.
Library Catalogue Search Results

Using the **Keyword** search, you’re able to use phrases and Boolean operators to find useful material.

Enter your search terms  
"food security" AND ("climate change" OR "global warming")

Clicking on the links for appropriate LC Subject may lead you to additional books on the subject.
Websites vs Journal Articles

**Question:** Why worry about finding journal articles? Everything you need is available for free on the Internet, right?

**Answer:** no 😞

A great deal of academic material is available by subscription only. You need to be able to locate and access this material. This includes **peer reviewed material**.

Peer Review

Peer reviewed journal articles are reviewed by academics in the same discipline chosen by the journal. It is an organised method for evaluating journal articles, certifies the soundness of methodologies, and establishes the plausibility of results.

Popular magazines may be interesting and informative, but tend to gloss over important details and provide overly simplistic explanations.

A peer-reviewed journal will normally include an **instructions to authors** section that outlines the editorial policy and peer review process.

Other clues include:
- may include the word journal in the title
- articles are substantial, written by an academic and include a list of references
- scholarly journals generally aren’t as glossy and “pretty” as popular magazines

‘Submit your paper – Guide for authors’ section from the journal, *Environmental Science and Policy* explains how the review process is undertaken.

**Review process:** All eligible papers are reviewed on the basis of the criteria of originality, quality, policy relevance and suitability for interdisciplinary audiences. Manuscripts are reviewed by at least two reviewers chosen by the editors from among the suggested and other potential reviewers. The authors may be requested to revise conditionally accepted manuscripts within 8 weeks of the receipt of reviews. The Editor-in-Chief approves manuscripts for publication.
Using Databases to Find Journal Articles

Journals come in either electronic format or hard copy. To find journal articles on your topic, you need to use a database.

**What is a database?**

A database is an index to journal articles. It contains information about the article including author, title, source, year, and often an abstract. The database doesn’t contain the article itself, instead containing the information you need to find the article. Many databases have links to the full text.

**How can I access databases?**

Databases are linked from the Library website (http://anulib.anu.edu.au). Click on the first letter of your database to get to the database you need.

Alternatively, you can search SuperSearch directly from the Library homepage.
Useful Databases for Environmental Sciences

Please remember that no database covers everything (not even Google!), so you may need to check more than one. All of the ones listed are accessible through the E-resources and databases link on the ANU Library Homepage.

Multidisciplinary Databases

- **SuperSearch**: provides a single search across the Library’s print and electronic collections. It is a useful service for undergraduates looking to search a wide range of material through a single search box
- **Scopus**: a large multidisciplinary database with a strength in the sciences and a focus on scholarly and peer reviewed literature
- **Google Scholar**: Google’s version of a scholarly database

Subject-Specific Databases

- **ABI/INFORM Complete**: economics and social sciences
- **APA-FT**: Australian Public Affairs - Full Text
- **CAB Abstracts**: agriculture, forestry, and management and conservation of natural resources
- **EconLit**: international economic literature
- **Sociology database**: sociology

Scopus

Why would I use it?

Scopus is a multi-disciplinary database, providing access to quality web sites in science and technology. It also has coverage of more than 20,000 peer reviewed journals in science, social sciences, and humanities.

Select ‘S’ for Scopus from the alphabetical list under E-resources & databases on the ANU Library homepage [http://anulib.anu.edu.au/](http://anulib.anu.edu.au/)

E-resources & databases »

Scroll down and click on the link for Scopus.

<table>
<thead>
<tr>
<th>16. Scopus</th>
<th>Hide details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scopus is the largest abstract and citation database of peer-reviewed research literature with more than 20,500 titles from more than 5,000 international publishers. Scopus offers researchers a quick, easy and comprehensive resource to support their research needs in the scientific, technical, medical and social sciences fields and arts and humanities.</td>
<td></td>
</tr>
</tbody>
</table>
Enter your search strategy, for example:
(cfc$s \text{ OR} \text{ chlorofluorocarbons}) \text{ AND} (\text{market} \text{ OR} \text{ regulat}* \text{ OR} \text{ legislat}*) \text{ AND} (\text{ozone} \text{ OR} "\text{climate change}"")

Some tools used in this search:

- **Boolean**: note the use of Boolean operators AND & OR.
- **Phrase searching**: note the double quotes that are used to search for a phrase (eg, “climate change”).
- **Truncation**: Note use of the asterisk to search for words with variant endings. For example, regulat* will search for regulate, regulation, regulatory.
When you see your results, try changing out the sort order to bring the highest cited results to the top of the list.

Scroll down to see brief records of the citations your search has found, including the title of the article, the author(s), the journal in which the article appears and the date of publication.
You can also use the limits on the left-hand side of the results to limit your search results by publication year, document type, subject area, and more.

To view more information about an article, click on the title.

You can now see more information about the article, including the abstract and any citing or related documents.

Click on the **Find it at ANU** button to view the different options for accessing full text.

---

**5 Minute exercise:** Using **Scopus**, find case studies on how carbon sequestration affects environmental sustainability.
SuperSearch

Why would I use it?
SuperSearch provides a single search across the Library’s print and electronic collections, with direct links to full text articles. It is a Google-type search.

Go to the Library website ([http://anulib.anu.edu.au](http://anulib.anu.edu.au)) and enter your search in the SuperSearch window.

You will then see your initial results. Use the options on the left to refine your results, for example limiting to scholarly material.

Click on Full Text Online to view the article, or to get more information about the resource.

5 Minute exercise: Using SuperSearch find a peer reviewed article on how social choice affects sustainability.
Google Scholar

Google Scholar can be searched in the same way as Google.

Google Scholar also has an advanced search option, allowing you to narrow in on relevant material.

To access the advanced search, click on the 3 horizontal bars in the upper left-hand corner of the browser window and select Advanced Search.

Many of the articles indexed in Google Scholar without online links may be available via the ANU Library.

If there is no ‘Find it at ANU’ link, look the title of the journal up in the Library catalogue. If you are off-campus, make sure you go into Settings > Library Links to set your affiliation to the ANU- Find it at ANU.
Select **Settings button** from **Google Scholar**

Click on **Library links** options to choose up to 5 libraries. You can also select your preferred citation management tool with the bibliography manager on the search results page. (optional)

Hit **Save** and conduct a search in **Google Scholar**.
Google Advanced Search

Advanced Google search allows you to narrow down search results for complex searches by using the features of the Advanced Search. Key features that can be used include phrase searching, limiting by a particular file type and restricting to domains and domain names.

For example:

Find articles
with all of the words             pacific islands
with the exact phrase            food security
with at least one of the words   fiji tuvalu
without the words                australia
where my words occur             anywhere in the article

Return articles authored by      e.g., "PJ Hayes" or McCarthy
Return articles published in     e.g., J Biol Chem or Nature
Return articles dated between    2013 — 2015
e.g., 1996
Evaluating Internet Material

Evaluation criteria

Authority and reputation of the source

- Who provides the information?
- Are the author's title and institution/company displayed?
- Is there a link to the author's email address?
- Does the URL indicate what type of organisation the information is coming from? What, if anything, does this tell you about the credibility of the information?
- If a trade publisher or organisation, is the source reputable, a recognised authority?

Information integrity

- Is the information current and up to date?
- Does the author give the source for the information?
- Is there evidence of bias in the information?
- Can the information be verified elsewhere?
- What is the purpose of the page? Is it simply a marketing tool?

Exercise:
Go to the links below look at the sites listed. Are they credible?
http://quicklink.anu.edu.au/wx7z
http://quicklink.anu.edu.au/3ng1
http://ql.anu.edu.au/j4j3

Referencing

You are required to use the Fenner School Referencing Style, as outlined in the FSES Referencing Guide. Below are some sample references taken from the guide. Please refer to the guide itself for full information.

Note: some of these entries have been altered for consistency and to provide examples.


EndNote for managing citations and research

EndNote is installed on all Info Commons computers at the ANU. If you’d like a copy for your own PC or laptop, head to EndNoteX9 on Wattle for information on downloading the latest version of EndNote.

What is it?

EndNote is a reference management website and software package available to ANU staff and students. It is able to assist you throughout the various phases of your research. EndNote can:

- Assist you with compiling a list of sources you find useful to your research
- Keep track of your notes and annotations for each source you read
- Insert properly formatted in-text references into your writing, as well as keep track of those references for automatic inclusion in your bibliography

Creating an EndNote Library

- With the EndNote program open, go to the File menu
- Choose New
- Type in an appropriate file name e.g. BIO
- Locate the directory where you wish to store the EndNote files
- Click on the Save button

Importing References from Databases

Most databases allow you to export a full list of search results. Here is an example using Scopus. Perform your search. Check the boxes of the citations you want to export. Select Export:
Under Export choose **RIS Format** for EndNote.

If you are prompted to select a program to open the scopus.ris file, choose **EndNote X9** and click **OK**.

Your references should now be shown in **EndNote**.

**PDF import**

EndNote can extract reference information from a publisher-created PDF document (where this information has been added to the metadata using its Digital Object
Identifier, or DOI) and use this information to create a reference in your EndNote Library.

To do this:
- Open the EndNote Library that you wish to use.
- From the File menu, select Import and then File (alternatively select the Import button on the EndNote Library Window toolbar)
- Select Choose and locate the PDF file you have saved.
- From the Import Option drop-down of the Import File dialog box, select PDF.

**ENDNOTE TIP:** It is not recommended to select Discard Duplicates from the Duplicates drop-down list.
- Text Translation > No Translation
- Select Import

The record associated with the imported PDF file should now be displayed in EndNote and the imported PDF file will be attached to it.

To display all references go to the References menu and select **Show All References** or select **All References** on the My Library panel.
PDF Management

You can set your preferences to enable automatic importing of PDFs from a designated folder on your computer. Any time you add new PDFs to this folder, EndNote will automatically import and rename them using the naming convention of your choosing.

Go to **Edit** choose **Preferences** choose **PDF Handling**. Choose auto renaming option e.g. Author + Year (N.B. This does not affect the file name in the original folder).

Select **Enable automatic importing** and select the folder you wish to use. If the reference is already in your Library it will attach the PDF to it. If not, then it will create a new reference and attach the file.
Find Full Text and Open URL Link

EndNote now provides two ways to find full text from your EndNote references.

Find Full Text searches ANU Library holdings for full text articles from inside your Library, and automatically imports articles.

In addition, EndNote can perform an OpenURL search to find full text or other options for the references in your Library.

OpenURL Link connects you to Find it at ANU (the ANU’s link resolver) and shows the various options available for finding full text.

Find Full Text

To find full text:

- Select the relevant reference(s)
- Under the References menu, select Find Full Text > Find Full Text... or click on the Find Full Text icon
You can configure automatic Find Full Text following the steps below:
Under the Edit menu, select Preferences then select Find Full Text and click OK.

If you are using EndNote on ANU’s campus from an Information Commons computer, in the “Authenticate with” box, you may need to delete the URL https://virtual.anu.edu.au/login.

If you are using EndNote off campus from a personal computer, in the “Authenticate with” box, you may need to add the URL https://virtual.anu.edu.au/login.
As full text articles are located, they will be automatically added to your EndNote Library, indicated by the paperclip symbol. Search progress can be viewed in the My Library pane under Find Full Text.

Note: the full-text PDF files are stored in your EndNote Library’s .DATA folder (e.g. Libraryname.DATA). If you download a number of full-text articles, this folder will get quite large.

- To view the full text article, select Found PDF Library and click and highlight a reference.
- Click on Open PDF in a reference window.
- You can highlight, underline, strikethrough, and add notes directly within the PDF.

Results can be mixed. Sometimes EndNote is unable to find articles even if the ANU has a subscription. In this case, try OpenURL Link. You can also manually attach PDFs to references after downloading them.
OpenURL Link
Rather than automatically downloading and saving full text, using OpenURL Link will provide you with several options for finding the article, including links to available full text, Library catalogue searches, and document delivery options.

To use OpenURL Link:

- Select the relevant reference
- Under the References menu, select URL > OpenURL Link or right-click on the reference and select URL > OpenURL Link.

A web browser window will open to show the full text or options for finding the complete article.
Inserting EndNote citations into a document

- Go to EndNote and click on the required reference. If multiple references are to be inserted, hold down the CTRL key while clicking on the required references.
- Go to Word and place the cursor in the desired position.
- Select the EndNote tab.
- Click Insert Citation and choose Insert Selected Citation(s)

Formatting the bibliography in Word

Your bibliography will be formatted using the style that is currently selected in EndNote. You can change the style both from within EndNote and Word. In Word under the EndNote X9 tab, click on the pop-out arrow under the Bibliography section.
You will now have the **Format Bibliography** pop-up window.

Select your output style from the quick list, or select **Browse...** to see all styles installed with EndNote.

Please refer to your course Wattle site for the full EndNote X9 booklet.
ArticleReach

**ArticleReach** is a journal article supply service available free of charge to ANU staff and students. It is able to supply PDF copies of journal articles normally within a two day period.

For more information on **ArticleReach** go to [http://quicklink.anu.edu.au/bsmh](http://quicklink.anu.edu.au/bsmh)

BONUS+

BONUS+ is a free resource-sharing service that allows ANU students and staff to borrow selected Library material from a consortia of participating Australian and New Zealand university libraries and pick it up from one of our branches.

For more information on **BONUS+** go to [http://quicklink.anu.edu.au/fdrp](http://quicklink.anu.edu.au/fdrp)

Document Supply Service

If no Library in the ACT holds the book or journal you require, our Document Supply Service will try to obtain it for you. If it is a book, we’ll try to borrow it from another Library in Australia.

For more info on **Document Supply Service** go to [http://quicklink.anu.edu.au/bu2z](http://quicklink.anu.edu.au/bu2z)

Off-campus access

Databases and electronic journals and books can be accessed from off-campus via Virtual. Go to [http://virtual.anu.edu.au](http://virtual.anu.edu.au) and log in using your student ID and password.

For Further Assistance

If you need additional help with any of the material covered in the Library lectures or tutorial sessions on Internet resources or finding key journal resources for your essay, please feel free to contact:

ANU Library Information Desks; science.Library@anu.edu.au (ph: 6125 3517)
Other resources

Training notes
To access training notes, visit the Research & learn webpage at anulib.anu.edu.au/research-learn and select the skill area followed by the relevant course. You can register for a workshop and find other information.

Research & learn how-to guides
Explore and learn with the ANU Library’s how to guides (anulib.anu.edu.au/howto). Topics covered are:

- Citations & abstracts
- E-books
- EndNote
- Evaluating Sources
- Finding books and more
- Finding journal articles and more
- Finding theses
- Increasing your research impact
- ORCID ID (Open Researcher and Contributor ID)
- Research Data Management
- Text and Data Mining
- Topic analysis

Subject guides
Find subject-specific guides (anulib.anu.edu.au/subjectguides) and resources on broad range of disciplines. Such as:

- Asia Pacific, Southeast Asia and East Asian studies
- Business, economics, art, music and military studies
- Criminal, human rights and taxation law
- History, indigenous studies, linguistics and philosophy
- Biological, environment, physical & mathematical sciences, engineering & computer science, health & medicine

Navigating the sea of scholarly communication
An open access course designed to build the capabilities researchers need to navigate the scholarly communications and publishing world. Topics covered include finding a best-fit publisher, predatory publishing, data citations, bibliometrics, open access, and online research identity. Five self-paced modules, delivered by international and local experts/librarians (anulib.anu.edu.au/publishing).

Online learning
Online learning is available through ANU Pulse, which can be accessed from both on and off campus by all ANU staff and students (ql.anu.edu.au/pulse).

Modules available in ANU Pulse
- Microsoft Office (Access, Excel, OneNote, Outlook, PowerPoint, Project, Visio, Word)
- Microsoft Office (Mac)
- Adobe suite (Illustrator, Photoshop)
- Type IT

Training
A range of workshops are offered to help with your academic research and studies (anulib.anu.edu.au/training-register).

Feedback
Please provide feedback about workshops on the online feedback form (ql.anu.edu.au/survey).